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With the increasing importance of social distancing during the corona virus pandemic, 2RPH 

like most other broadcasters will operate with the maximum possible amount of program 

content being produced at home. Naturally, the quality of the programs will not be as good 

as that usually produced in our studios, but in these circumstances the continuation of 2RPH 

broadcasts will be far more important to our listeners than a slight drop in technical quality. 

With relatively basic equipment you will still be able to produce a good recording. These 

Notes are intended to help you in that process. 

To create programs at home the basic set up you will need is: 

• A computer, laptop, tablet or smart phone, with capacity to store and send audio 

files 

• A microphone – even an earbud/mic combination will work reasonably well 

• Headphones or earbuds 

• A suitable location, and 

• Audio recording software; there are many available and some are free. 

These Notes will cover both the home recorded program option, and contributions from 

home to the studio, as well as recording presentations by several people in different 

locations linked by conferencing software. 

Recording programs at home will involve using new tools, so be sure to allow yourself plenty 

of time, particularly for learning and practicing with new software. 
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1. THE RECORDING / REMOTE BROADCASTING ENVIRONMENT 
No matter what microphone or recording device (computer, tablet or phone) you use for 

home recording or broadcast, the quality of the result will depend on the recording 

environment or space you use. Here are some tips for selecting a suitable 

recording/broadcast space: 

• Ensure you are in as quiet a location as possible. 

• Try and pick a less busy time of day to record, when street noise and other outside 
sound is least likely.  

• Avoid use of washing machines, dishwashers, fans, air conditioners or other 
appliances while you are recording, as the sound they make travels a long way and is 
easily picked up by microphones. 

• Ideally, do your recording or broadcast in a space with less hard surfaces for the 
sound of your voice to bounce off. 

• Using a room with carpets and curtains or other soft furnishing is a good idea. A 
bedroom may work very well.  

• Bathrooms and kitchens should be avoided.   

• An easy way to test a room is to clap your hands and listen for an echo sound. The 
less echo the better. Try clapping your hands in a bathroom then in a bedroom, and 
you’ll hear the difference. 

• If you are sitting at a desk, try a piece of material, carpet or a towel on the desk 
surface to reduce the reflective sound of your voice. 

• Finally, do some test recordings in a couple of potential spaces, listen back and 
decide which location sounds best to you. 
 

2. MICROPHONES AND HEADPHONES 
There’s a huge range of headphones available and as long as it has a plug that fits your 

recording device it should be fine. However, avoid Bluetooth headphones. In some 

circumstances, they will introduce delay between the voice being recorded and what 

you hear in the headphones which makes it very difficult to work. 

Microphone Techniques 

There are many options available, but whatever you use, the distance from your mouth 

to the microphone is important.  

If you are using a microphone similar to those in the studios or a USB Microphone, then 

employ a handspan distance between your mouth and the mic. As in the studio, avoid 

speaking directly into the microphone, instead doing so at about 45 degrees, to 

minimise ‘popping’. 
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If you are using a computer’s inbuilt microphone or your phones inbuilt microphone, you 

need to do some tests and establish the best distance to be from the device. It will likely 

be optimised for your normal user position, but do a test and listen to the results. 

If you use a combined microphone/earbud device, to avoid audible rustling sounds on a 

recording caused by your movement, try taping the cable to your clothes to minimise 

any cable movement.  

In all cases do some test recordings with different combinations to work out what sounds 

best.  

Microphone choices  

Your choice will depend largely on your budget. But rest assured, you can get a good 

quality recording with minimal cost. 

Reasonable Result 

To record into a computer, laptop, phone or tablet you can use the built-in microphone. 

Depending on the recording environment (see Recording/Remote Broadcasting 

Environment above) along with the age and quality of the device, you may achieve an 

acceptable result. 

 

You’ll likely get a better result by using an external mic and by wearing 

headphones/earbuds. Here are some suggestions. 

Good Result 

Try a combined microphone/ earbud device similar to those that come with mobile 

phones. They should be able to plug into the audio socket of your phone, computer or 

tablet and in most cases they will produce a recording of acceptable quality. 

 

 

 

A headset mic combination such as those used for handsfree phone calls and the like 

should also be an option. 
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Better Result 

USB microphones (for computer or tablets with USB ports). 

They look like traditional mics in the studio, but connect directly to your computer via a 

USB cable. Do not connect via the keyboard as this may cause delay problems. They 

range in price and quality and can produce very good recordings.  

Unless your recording space is exceptionally quiet a cheaper dynamic USB microphone 

will be better than a condenser. 

The USB mic should have a headphone socket built into it and you will be able to plug 

any headphones or earbuds directly into the mic to listen back to your recordings or 

broadcast, without experiencing any echo or delay (zero latency). 

 

The Samson Q2U is an example of a versatile dynamic USB Microphone. It connects to a 

computer via USB but can also connect to professional audio gear via an XLR connector. 

It also has a headphone socket to allow monitoring without echo or delay (zero latency). 

It costs around $120.00  

Best Result 

Professional Microphone such as those used in the 2RPH studios. 

However, to connect these to your computer or phone you will need an additional 

interface. Again, unless your recording space is exceptionally quiet, go for a cheaper 

dynamic microphone rather than a condenser. 

Below is an example of a USB Interface that allows a professional microphone to be 

plugged into a computer. 

 

  



2RPH NOTES ON HOME PROGRAM PRODUCTION v2.1  Page 5 of 18 
 

 

3. AUDIO SOFTWARE 
There is a wide range of audio production software, some of which may only be available for 

certain operating systems or devices. There are some reasonable quality products available 

free of charge. Below is a summary of these products. 

Audio Software Device OS Record Trim  
Full 
edit  Cost 

Zoom All All  X X Free 

Cleanfeed 
All 

All. Requires Chrome 
on computers, Safari 
on iPads, iPhones  X X Free 

Windows Sound/Voice 
Recorder PC All   X Free 

Apple Voice memos Mac All   X Free 

Various Voice record aps iPad All   X Free 

GarageBand Mac All     Free 
   iPad Version 13     

Audacity PC All    
Free 
   Mac 

OSX 10.7 to 10.14 
Not Catalina    

WavePad All 
Win7 up, Mac 10.5 
up, iPad 6.0 up    

Free 

Adobe Audition PC Win 10 or higher    
Monthly 
$30 

  Mac 
OS X v 10.12 or 
higher    

Hindenburg 
PC All     $139 

Mac OSX 10.5-10.15 / Cat     

 

APPLE VOICE MEMOS 
This is a basic product which does what the name implies - records voice memos. Apart from 

recording, limited editing is available. Files are saved in m4a format. 

 

The Windows equivalents, Windows Sound or Voice Recorder are similar to Voice Memos.  

These apps are not recommended for use for 2RPH program recording. 
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5. GARAGE BAND 
 

(A) These are basic instruction for use of this software on Mac devices with OS 

earlier than Catalina: 

Open GarageBand. 

 
For a new project select ‘Voice’. 

You’ll get a project with 2 tracks. 

Clicking on the panel ‘male basic’ or ‘female basic’ will select which track to record 

on. 

On the ‘clock panel’ at the bottom, click the ‘quaver’? to alter timer to be set to 

‘time’ rather than measures. 

Click the ‘red button’ to the left of the timer to record. 

Double click the recorded track for a magnified ‘audio region’ near the screen 

bottom. This ‘region’ seems to allow better view of waveforms, but is not useful for 

editing it would seem.  

New recording is placed at where the ‘play head’ is - upside down arrow & red line. 

No warning of over record is given. ‘Apple z’ will undo. 

Trimming can be done in the ‘main track display’. Drag edge. 

The system default appears to store completed projects in the ‘garageband app’ 

folder. You could also create a ‘Garage Band Projects’ folder within my documents 

folder and direct saved projects there. 

To save the file as MP3, go to the top menu item - Share - Export ‘Song’ to disk - then 

- checkbox compress, compress using: Mp3 Encoder. Audio setting: ‘High Quality’.  

The file can be stored where you choose. 
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(B) Garageband on iMac running Catalina (Garageband Version 10.3.4) has a quite 

different appearance to its predecessor. 

A recommended guide is the following YouTube video: GarageBand Tutorial for Beginners - Record 

Audio Vocals, Edit, and Export to MP3 

https://www.youtube.com/watch?v=YcLQ0f5vC7w 

This guide is explicitly for voice - spoken, rather than singing and thus relevant to our situation. 

 

(C) The iPad version of Garageband is different again, but similarly is fairly 

straightforward to use, with automatic or manual audio input levels. 

 

Music or program theme files can be added as additional tracks after they have been saved 
on to the iPad. 
 

 
 

Recordings are saved as Songs and can be ‘shared’ to other apps such as Dropbox or 

emailed. They are saved in the m4a file format. 

 

  

https://www.youtube.com/watch?v=YcLQ0f5vC7w
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6. AUDACITY 
A beginner’s guide.  

AUDACITY is a free recording software program for use with PC’s and Macs (note: 

Audacity does not work with the latest Mac Catalina OS update).  

If you’re new to this kind of software, Audacity is probably a good place to start. 

(A) Download and install AUDACITY  

Hovering the mouse pointer over the various buttons on the screen gives a description 

of what that button represents. 

(B) The top left hand of screen has 6 buttons. They are (left to right): 

Pause 

Play (green button) 

Stop 

Skip to start 

Skip to end 

Record (red button) 

 

 Look for the sliders to adjust recording 

volume and playback volume 

 

(i)  For Apple Mac users 

Below in the centre are 4 pull-down tabs; hovering the mouse shows the settings: 

 

Audio host - leave at default 

Recording device - should default to current microphone plugged in 

Recording channels - for 2RPH select mono channel 

Playback device - defaults to current speakers/ headphones 
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(ii) For Windows users 

The same details appear as a panel and dropdown boxes, including the default microphone 

and speakers. 

 

 

(C) Preparing to Record 

Before you start recording, set the microphone level by clicking on the microphone icon or 

Start Monitoring, 

 

 

Then you can adjust the mic level with the slider below the level meter. 

 

  

(D) Record  

 

Press red button - a window will pop up showing the waveform of your voice.  

To pause - click on the pause button. To resume, press pause button again 

To finish - press the STOP button 

To replay - press the play (green) button 

Alternatively, pressing the space bar will play the recording from the start. Pressing the 

space bar again will stop the replay. 
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(E) SIMPLE EDIT 

With the project open, you can easily edit out unwanted audio segments 

such as a cough or an error in reading.  

First check that the selection tool is selected. 

On the recording track left click and drag the mouse to select the piece you want to remove.  

In the View menu you can select Zoom to expand the track making it a bit easier to see the 

selection. 

To remove the section of the recording you have highlighted, go to the Edit 

menu and select Delete or Cut, or press Ctrl + X on the key board, or click on 

the cut tool on the menu bar.  

If you’re not happy with the edit, press Ctrl + Z to undo. 

 

(F) IMPROVE AUDIO LEVEL 

If the voice recording is a bit low you can fix that by selecting the voice 

track – press Select at the bottom of the box on left-hand side.  

Then in the Effect menu select Normalise. 

You would not do this if you had deliberately recorded audio with louder 

and softer parts.  

 

(G) ADDING MUSIC OR OTHER AUDIO 

 

These are the basics of adding music or other audio files to your voice recording. 

You will need to have those audio files available on your computer in a suitable format – 

MP3 is best. 

In the File Menu go to Import and then select Audio. Navigate to 

the file you want to add and double click. As a music file is in 

stereo, a new set of tracks will appear. 

If needed, you can trim the music, as described in the basic edit 

section above. 

 

If you now play the project, all tracks will play at the same time.  
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Separate the tracks by time shifting them. First select the time-shift tool. 

 

In this example, we want a brief music intro before the voice track begins.  

Select the voice track by pressing Select at the 

bottom of the box on left-hand side of the track (as 

in 7. above). 

 

Then hold down the mouse whilst moving it down 

the time line, leaving a brief overlap with the end 

of the music tracks. 

 

 

 

 

There are several ways to create a simple fade at the end of the music 

tracks. One method is to click the selection tool again, and select the 

section of the music tracks which overlap the voice track. 

 

Then, under Effects Menu select Fade Out. 

 

 

 

(H) Save a Project 

In the File menu- select save as PROJECT and give it a name. Click on SAVE. 

You can save the project where you wish. 
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(I) Save an MP3 file for 2RPH 

Go to File Export - select Export as MP3 

Select the folder where you want the file to go 

Give your MP3 a file name (see section 7 on file 

naming) 

In Format Options: 

Set the bit rate mode to Constant 

Quality to 128kbps 

Tick Force export to mono 

Click on save 

 

Note: There are many YouTube videos describing editing and more advanced features 

for Audacity, see Resources section below. 

 

7. WAVEPAD 
Another free audio recording and editing software package is WavePad, which can be downloaded 

at https://www.nch.com.au/wavepad. It will work on Windows, Mac and there is an iPad version 

available from the App Store. 

 

WavePad is very straightforward to use and has lots of on-screen help and a range of tutorials 

explaining all the basic functions and features. 

8. TRANSFER FILES TO THE STATION  
Audio files recorded at home will be uploaded to 2RPH through the station’s Dropbox. A 

separate folder will be created for each program with an invitation sent to each producer to 

enable access to that folder. Then it would be a simple process to drag a completed 

program file to the appropriate Dropbox folder on your device.  

https://www.nch.com.au/wavepad
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Please contact the 2RPH Technical/Production Manager to set this up for your program.  

The preferred file format for recorded 2RPH programs is 128kbps MP3 files. However, m4a 

files are also acceptable, but will require further processing by the production team. 

Therefore, please discuss with the Technical/Production Manager if you need to use this 

format. 

The critical issues are to ensure the correct length of recorded programs uploaded and the 

have very clear labelling of files.  

AUDIO FILE NAMING 

The protocol required is to label each file with the date of broadcast (not the date of 

recording) in the form of YYMMDD followed by the name of the program (or an 

abbreviation).  

As an example, the file name for a Special Program recording to be broadcast on 30th July 

2020 which is in the MP3 format, would be:   “200730 special program.mp3” 

The system of Dropbox folders for each program will also enable program themes and the 

like for each program to be stored in the program folder for ready access. 

 

9. ZOOM – for live reading to 2RPH Studio 
These are instructions to join a Zoom enabled live broadcast from home. It is dependent 

on the Zoom host being in a 2RPH studio.  

Zoom, like Skype, is a medium used to hold meetings between two or more people 

remotely. Zoom tends to have better reception and easier functionality, plus it is free for 

any meetings of less than 45 minutes.  

2RPH has a Pro version, with unlimited time - so most meetings would be initiated by 

someone in the broadcasting studio. 

Here are some steps to follow at home when getting ready to broad cast live. 

A. Download Zoom following these steps:  

(i) Laptop/desktop 

Click this link: https://zoom.us/j/163608204 - it will prompt you to install an app (which 

is free/safe). 

(ii) Mobile app 

Available for Apple/iOS - https://itunes.apple.com/us/app/id546505307  

and Android - https://play.google.com/store/apps/details?id=us.zoom.videomeetings  

https://zoom.us/j/163608204
https://itunes.apple.com/us/app/id546505307
https://play.google.com/store/apps/details?id=us.zoom.videomeetings
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It is recommended that you do not use a mobile phone or landline to broadcast. Zoom 

will work with those devices but the quality of sound is very poor for broadcasting 

purposes.  

B. Invitation from 2RPH 

The Home page for Zoom on an iPad looks like this: 

 

 

 

 

At this stage, at home you would await an invitation from the person in the Studio 

(initiating the meeting) and any others also to be broadcasting during your program. An 

invitation to a Zoom meeting will look like this image below, however please ignore the 

telephone numbers (not shown here), and use the Zoom link to connect you to the 

meeting:  

_______________________________________________________________ 

2RPH is inviting you to a scheduled Zoom meeting.  

 

Topic: Breakfast Show 2RPH Zoom  

Time: Mar 28, 2020 10:30 AM Canberra, Melbourne, Sydney  

 

Join Zoom Meeting  

https://zoom.us/j/262895851?pwd=bWFqOTkxeXJOK0Y1cFg4VmFaRDUvdz09  

 

Meeting ID: 262 895 851  

Password: 072073  

 

Meeting ID: 262 895 851  

Find your local number: https://zoom.us/u/azRcWNBNP  

x-apple-data-detectors://0/
https://zoom.us/j/262895851?pwd=bWFqOTkxeXJOK0Y1cFg4VmFaRDUvdz09
https://zoom.us/u/azRcWNBNP
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______________________________________________________________________ 

C. Connecting to the Studio: 

Once you have joined the meeting, you may have to wait for the ‘host’ to initiate the 

meeting - you will be in a kind of ‘waiting room’. If it has already started, you will see the 

names and images of the other members of your team.  

There are options to ‘see’ people in either a Gallery version: 

 

Or individually (i.e. the person who is talking will be in view).  

Some notes to assist in operating: 

• note the Mute option - if you are not speaking, but instead perhaps sorting 

notes etc, please put the Mute button on so that no external noise is 

detected from your device to the studio.  

• find a suitable room – see the section on Recording/Remote Broadcasting 

Environment above 

• use any type of earphones and microphone you have in preference to just 

speaking through the devices open audio facilities. This optimises the quality 

of voice transmission and minimises any external noise/room noise.  

• starting the meeting early means that the team can speak to each other 

before the broadcast starts, so that articles etc. can be discussed.  

• there is a facility for being able to read your article on-line (either as a PDF, 

Scan, or open source web article etc). This is found in the ‘Share Content’ 

button – (top right hand on PC and iPad, bottom menu bar on Mac) green 

arrow symbol, as follows: 
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If you hit that button you will be given options to follow your files and documents and 

choose the piece you want displayed on the screen: 

 

• there is also a facility to send a message to your fellow team without 

interrupting with speech. This is under the three dots at top extreme right, 

and the Dropbox will provide the option to ‘Chat’. 



2RPH NOTES ON HOME PROGRAM PRODUCTION v2.1  Page 17 of 18 
 

 

Choosing Chat will take you to a box where you can choose which person (or all) you can 

send an SMS-type text to, without interrupting the flow of the broadcast.  

You may leave the meeting at any time; the button at top left of screen gives you the 

opinion to ‘leave’.  

Note: it is better to avoid having too much other internet activity happening at your 

home while conducting a Zoom session – two simultaneous Zoom sessions over one 

internet service can cause problems. 
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10. RESOURCES 
 

• The Community Radio Training Organisation (CMTO) Quick Guide to 
Recording your Show at Home: 
https://cmto.org.au/latest/840-quick-guide-to-recording-your-show-at-
home.html  
 

• A webinar on Creating Content Remotely conducted by the CBAA and CMTO 
was held on 26 March 2020. It can be accessed at 
https://cmto.org.au/latest.html and scroll down list of webinars. 

 

• CMTO notes on Audio Editing software for the Computer and Smartphone: 
https://cmto.org.au/what-we-do/projects/multiplatform/skills/80-
audio/577-audio-editing-software-for-the-computer-and-smartphone.html 

 

• Garageband tutorial: https://www.buzzsprout.com/blog/garageband-
podcast-tutorial 
 

• Voice Recording in the Home Studio: 

https://transom.org/2013/voice-recording-in-the-home-studio/  

 

• Use of smart phones for interviews and home recording: 
https://vimeo.com/83811743 

 

• Some relevant notes from Transom:  

https://transom.org/2020/recording-during-the-coronavirus-pandemic/ 

 

 

 

 

 

 

 

These notes have been compiled by John Berry, Mary Jane Hogan, Maria Issaris, John Martin, Colin Payne, 

Greg Richardson, Fran Telec and Peter Worthington, and have drawn on the CBAA / CMTO webinar on 

Creating Content Remotely, held on 26 March 2020. 

Your comments and suggestions on improvement of the Notes are very welcome, please send them to 

info@2rph.org.au 

Version 2.1   200416. Addition of WavePad and a Garageband Resources link. 
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